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Preface 
 

Welcome to Greenbrier Graphics, LLC 
Net Deed Plotter 

 

Net Deed Plotter (Version 5 of Deed Plotter) is our fourth Windows 

release, and it is our eighth major Deed Plotter revision. 

 

This release is, as always, in response to the wish list customers continue 

to submit.   

 

Net Deed Plotter is ideal for the individual who needs to determine the 

shape, area, and accuracy (closure) of survey descriptions. 

 

More than ever, we learn that our software provides very important results 

for our users.  Litigation is often avoided or its outcome decided by Deed 

Plotter. 

 

System Requirements 
 

Net Deed Plotter requires the following: 

 

¶ A Windows-based computer running Microsoft Windows XP® 

(with NET Framework 2) or Windows Vista®. 

¶ Approximately 3 ½ megabytes of Hard Disk Drive space.*  

¶ Approximately 10 megabytes of dedicated RAM.*  

¶ A mouse or other pointing device. 

¶ A monitor having a minimum resolution of 1024X768. 

 

All modern printers are supported. 

 
(*  See Installation and Requirements Help topic for exceptions and details.) 
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COPYRIGHTS, WARRANTY, and LICENSE 

COPYRIGHTS:  

Greenbrier Graphics, Greenbriar Graphics, Deed Plotter, Deed Plotter+, Deed Plotter+ for 
Windows, Net Deed Plotter, Deed Plotter.Net, and Deed Description Analyzer are trademarks of 
Greenbrier Graphics, LLC. All rights reserved. 

WARRANTY:  

Greenbrier Graphics, LLC, warrants the physical media (CD) to be free from defects in materials 
and workmanship for a period of 30 days from the date of purchase. In the event of notification 
within the warranty period of defects in materials and workmanship to the physical media, 
Greenbrier Graphics, LLC, will replace the defective media. The remedy for breach of this 
warranty shall be limited to replacement and shall not encompass any other damages including, but 
not limited to, loss of profit and special, incidental, consequential, or other similar claims. 

Greenbrier Graphics, LLC, specifically disclaims all other warranties, expressed or implied, 
including but not limited to implied warranties of merchantability and fitness for a particular 
purpose with respect to defects in the media and documentation, and the program license in 
particular. These disclaimers will apply without limiting operation of the program license with 
respect to any particular application, use, or purpose. In no event shall Greenbrier Graphics, LLC, 
be liable for any loss of profit or any other commercial or personal damage including, but not 
limited to, special, incidental, consequential, or other damages. Greenbrier Graphics does NOT 

warrant its software or manual to be error free. 

LICENSE:  

This software and manual (Net Deed PlotterÊ) are owned by Greenbrier GraphicsÊ and Paul E. 
McClung, its programmer.  Said software and manual are protected by United States copyright laws 
and by international treaty provisions. 

Greenbrier Graphics, LLC, grants to the licensee a nonexclusive right to use this (single) copy of 
Net Deed Plotter on a single computer for use at one location. This software or manual shall NOT 
be distributed, rented, leased or sublicensed by the licensee.  Greenbrier Graphics, LLC, defines a 
site license as a special license to install our software for multiple users at a single location. 

Greenbrier Graphics, LLC, reserves all rights including, but not limited to, modifications and 
distribution of this software and manual. 

If you do not agree fully with the terms, definitions, restrictions, and conditions herein set 

forth, remove all copies of this software from your computer and immediately return the 

software and manual in undamaged condition to Greenbrier Graphics, LLC. Failure to 

comply with all terms, restrictions, and conditions shall constitute breach of this agreement.  

These statements shall be construed, interpreted, and governed by the laws of the State of West 
Virginia. 
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Introduction 

Welcome to Net Deed PlotterÊ 

Whether you are going to draw a simple legal description once in six 

months or draw legal descriptions every day, Net Deed Plotter is for you. 

If you want only a map and essential data, you can skip a significant 

portion of the manual.  Background images and other powerful options we 

offer are ready if you ever need them.  We keep the advanced features out 

of your way.  Use what you need and ignore the rest. 

As always, Deed Plotter is designed to provide maps and technical data for 

those involved in real estate at a professional level.  We do not expect you 

to be a surveyor or engineer. 

Version 5 of Deed Plotter is distinguished by the name Net Deed 

PlotterÊ. 

The design (programming) of Net Deed Plotter was on a Windows 

XP® (SP2) based computer AND on a computer that used the Vista® 

operating system. 

In the Getting Started topics, you will see how easy it is to enter deed 

calls into Net Deed Plotter and draw a map.  It is important that ALL new 

users understand those topics and the general entry of Net Deed Plotter 

data. 

If legal descriptions are reasonably well written, our Deed ConversionÊ 

wizard can often read the deed calls directly from the deed and 

automatically format the deed calls to the final protocol Net Deed Plotter 

requires.  After you have learned the basic concepts of entering deed calls 

directly into our Deed Call Editor, you may want to see if Deed 

Conversion works for you.  
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Installation and Requirements 

We recommend that, especially for Vista operating systems, Net Deed 

PlotterÊ be installed under Administrator Rights. Any run-time error 

(unhandled exceptions, etc.) that may occur during or after installation is 

probably the result of not doing so. 

As you will learn in the Copy Protection and License Activation page 

that follows, any license(s) you have purchased, and continue to have, 

must be activated after installation.  It is important that you also refer to 

our Help topic for additional information.  To do so, please select Deed 

Plotter Help from the Help menu, and then select the Copy Protection 

and License Activation topic. 

This version of Deed Plotter is based on the latest programming 

technology offered by Microsoft.  This new technology is known as the 

.Net Framework. Therefore, Greenbrier Graphics has again changed its 

programming language to provide you with leading-edge-technology.   

Deed Plotter now requires version 2 or later of the .Net Framework.   This 

is one reason we require Windows XP with service pack 2 or Vista.  If 

you are using XP and Net Deed Plotter fails to run, you probably do not 

have an up-to-date version of .Net Framework 2.0.  XP users can find 

important information concerning this in the Support topic at our Web 

site. 

Net Deed Plotter looks at the paper size and other important information 

concerning the specific printer(s) you will be using.  It is important that 

you have at least installed a printer driver.  It is not required that the 

printer actually be turned on or connected.  
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Copy Protection and License Activation 

Regardless of the method (CD or download) you used to install Net Deed 

Plotter, it will eventually expire if the license has not been activated.  

If you have purchased, and continue to have, one or more valid licenses, 

you are entitled to activate the license(s) at your convenience.   

Whether you have downloaded Net Deed Plotter or received it on a CD, it 

is never limited in functionality.  You will have access to every feature 

without limitation.  If a trial period remains, it will briefly be indicated in 

the status bar each time Net Deed Plotter begins to run. 

The copy protection currently used with this version of Deed Plotter is 

designed to be user-friendly for our customers.  Menus relative to copy 

protection are visible only when relevant.  If you change the status of your 

license, any menu no longer needed may disappear or a new one may 

appear. 

This copy protection remains effective even if you re-format or replace the 

hard disk drive, change various circuit boards, reinstall/update Windows, 

or a host of other changes that alter portions of your computerôs 

"fingerprint." 

If you are entitled to activate a license on more than one computer, it 

would be prudent to carefully select the computers to be activated.  Using 

a license on an unauthorized computer could result in your not having 

enough licenses for needs that may arise later.  

There are two methods commonly used to activate a license.  The Internet 

Activation option will require that you have already received a 15-digit 

Internet Activation License from Greenbrier Graphics. 

The ñphone/e-mailò option will require that we receive an Installation ID 

from you so as to compute an Unlocking Key unique to the computer 

being activated. 

The steps presently used for license activation are on the next page.  
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License Activation Process 

The steps provided below are currently used when you need to activate a 

license.  Over the life of this manual the exact steps may change, but these 

steps will remain reasonably useful.  If the steps change significantly, you 

will find the updated method in a Help topic. 

These steps are based on the assumption you are a registered user of Net 

Deed Plotter and currently have a valid license to use the software. 

The current steps for activation within the trial period are as follows: 

1. During the trial period, an Activate License menu will be visible 

on the Deed Call Editor until you have activated the license for 

that particular computer.  

2. When you click the Activate License menu, a form will appear 

that will guide you through the license activation process. 

3. If you have received a 15-digit Internet Activation License number 

from Greenbrier Graphics, select the Internet Activat ion option; 

otherwise, choose the Manual Activation  option. 

If you attempt to run Net Deed Plotter AFTER the trial has expired, 

the aforementioned form will appear automatically. 

IF you are using the ñphone/e-mailò activation option to activate a license, 

the Installation ID you will be providing Greenbrier Graphics is unique to 

that computer.  It is not possible to license two or more computers by 

using the same Installation ID or Unlocking Key.  

After a license is activated, the Activate License menu will disappear, and 

there will be no message pertaining to the days left before expiration. 

After activation, there will be a Move/Remove License menu option in 

the Help menu.  This menu is used to manually move the license to 

another computer or to remove a license.  The Move/Remove License 

menu option also provides a method to deactivate a license.  If you 

originally used the Internet Activation option, you may be able to store or 

move a license in this manner.   
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Features and Changes 

(Our goal remains finding a way to make Deed Plotter even easier to use.) 

¶ Icons available for the common tasks. 

¶ Accepts directions, distances, and curve data to obtain a scaled map that can include 
multiple tracts and structures.  

¶ Cardinal directions can be entered directly.  

¶ Complete, full-featured help.  

¶ Editing of deed call data now includes Cut, Copy and Paste.   With this version of Deed 

Plotter, the editor is a word processor editor.  For example, when you press the ENTER 
key, a line break will occur. 

¶ Many metes and bounds descriptions can be read directly from your word processor.  

¶ A powerful Analyze menu option helps solve tracts that have poor closure.  

¶ Permits user-selected scale and zooming.  

¶ Determines area, net area, closure, and precision.  

¶ Directions can be bearings, azimuths, deflections, and interior angles.  

¶ Distances can be feet, meters, varas, chains, rods, poles, perches, and links.  

¶ Special curve editor provides powerful curve handling capabilities.  

¶ Distances can be converted to new units in any order, at any time.  

¶ Text can be added to your map. This text can be sized and rotated.  

¶ The map is always drawn in a print layout view.  

¶ Can be put in "metric" mode for the inputting and printing of metric data.  

¶ Individual deed call can be omitted.  

¶ Accepts references to standard government sections and permits direct entry of 
rectangular surveys.  

¶ Uses a "?" feature to solve missing line, curve, or radius.  

¶ Tracts can optionally be rotated by automatically rotating deed calls or by a rotation 
value.  

¶ Finds direction and distance from any point on a property line to any other visible point.  

¶ The mouse can drag tracts and text where you want them.  

¶ Menu items that make your map fancy include broken lines, colored lines, deed call 
labeling, and circling corners.  

¶ Data, including date and title, can usually be included in a "data box" on same sheet as 
the map.  

¶ DXF files can be exported for use with CAD and GIS programs.  

¶ Bitmap (.bmp) files of your maps can be saved for exporting.  

¶ The mouse can be used to create a tract. The calls will be placed in the data editor.  

¶ Create an easement or right-of-way from baseline description.  

¶ Keeps and Exceptions can be indicated to calculate net area.  

¶ Optional entry of x, y (including state plane and utm) coordinates. 

¶ The x, y "corner" coordinates can be saved as a text file. 

¶ A geo-referenced image (topo maps, etc.) can be placed in background.
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Getting Started 

Overview 

Since 1987, Greenbrier Graphics has earned its reputation for developing 

easy-to-use deed plotting software.   Net Deed PlotterÊ is the easiest to 

use, but yet the most powerful Deed PlotterÊ ever to be released. 

As a beginner you will appreciate the fact that no surveying or engineering 

background is needed.  

This Getting Started section contains the most important discussions you 

will read.  The discussions within this section and the examples we use 

will enable you to begin drawing many real world descriptions 

immediately. 

Our example entitled ñImage Exampleò is of particular importance, and 

we recommend that it not be deleted.  Image Example shows off the 

ability of Net Deed Plotter to display background images, and it is referred 

to later in this manual. 

Our Help topics detail a menu-by-menu and icon-by-icon breakdown 

regarding the Editor Menus, Map View Menus, and Icons. 

The layout of this manual is to present information on an as-needed basis.  

For example, if you are interested in displaying more than one tract, you 

will be learning the relevance of the Merge File menu.  A significant 

portion of this manual contains the same information as our Help topics, 

but important differences are as follows: 

¶ Topics that will change with time will be updated only in the Help 

topics.  (There is an appendix in Help that references version 

changes, bug fixes, updates, etc.) 

¶ The manual is better designed to provide a tutorial for those new to 

Deed Plotter and for those using the more common features. 

¶ Advanced features (such as background images) will be mentioned 

in this manual, but the reader will be guided to Help topics for 

details. 
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Your First Map  

To see how easy it is to use Net Deed Plotter, we will enter a few basic 

deed calls and draw the resulting map. 

The steps to create your first map are as follows:  

1. If you have shut down Net Deed Plotter, launch (start) it again.  

Then you can optionally select the New icon, but if you had no 

previous project, that is not required.  

2. Type the four deed calls listed below into the Deed Call Editor.  

Each goes on a separate line. 

n0e 100 

n90e 100 

s0w 100 

s90w 100

 

The screenshot on page 3 shows these entries. 

Notice that there is a space between each direction and the 

corresponding distance (but there are NO other spaces).  The "0" is 

a zero, not the character "o".  The n, s, e, w characters can be upper 

or lowercase. 

3. Draw the map by clicking on the Draw Map  menu option.  You 

could also have drawn the map by pressing the F2 function key or 

by moving the mouse cursor onto the "paper" form that is to 

contain the map, then clicking the Left Mouse button.  

4. The Editor should no longer be visible, and the simple square tract 

you have created will appear.  The icons and menus relative to the 

map view are no longer grayed out. 

5. One icon of particular importance is the AutoScale icon.  This 

is the colored icon that has small red arrows pointing toward its 

center.  You can click this icon to rescale (AutoScale) and/or re-

center the map, but it should not be used if you are happy with the 

map scale.  If the CONTROL  key is pressed when you click this 

icon, the map will center without altering the scale. 
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6. If you move the mouse into the map, data for that tract will appear 

in the status bar. You can also scroll the view and see the tract data 

at the bottom of the map. 

7. If you click the Left Mouse button while the cursor is in a tract, 

that tract will be selected (made active) and will show with dashed 

red borders. As you will learn in other topics, selecting a tract can 

be very important. 

8. Return to the Deed Call Editor by clicking on the Editor  menu, the 

Editor  icon, or by pressing the ESCAPE key. 

Net Deed Plotter looks at the paper size and other important information 

concerning the specific printer(s) you will be using. It is recommended 

that you have at least installed a printer driver. It is not required that the 

printer actually be turned on or connected.  

Now that you have a feel for the basics of Net Deed Plotter, you are ready 

to quit this project and move on to other topics. The Entering Deed Calls 

topic is one you must not skip. 
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Opening and Saving Files 

There are several example files you may want to open as you learn to enter 

deed calls.  We suggest you open the example titled ñImage Exampleò to 

see the potential of Net Deed Plotter.  The use of background images is 

optional and can be ignored.  The Image Example files will be used later if 

you want to learn more about background images. 

The Open and the Save sub-menus are in the File menu.  We discuss 

other Deed Call Editor menu options where relevant.  Net Deed Plotter 

uses a new ñndpò file extension for its proprietary files. 

Older Deed Plotter (Version 4) files can also be opened by selecting the 

Open Version 4 File menu.  The only loss in the older files is any custom 

text you may have added. 

When Net Deed Plotter is installed, default paths are set for all files it 

uses.  These paths can be reset; however, the occasional change of a file 

path is not reason enough to change the default file path(s).   

When the Deed Call Editor is visible, you have access to the Setup menu.  

To change a file path, select the File Pathôs sub-menu.  You can select the 

current file path by clicking on it or by using the UP/DOWN Arrow keys, 

and then select the Modify  button.  You can now browse your way to the 

path that is to become the new default and select it.  You can change only 

one file path at a time; however, you can repeat the process for other file 

types as needed. 

There is also a Reset All button available.  If you ñreset all,ò ALL file 

paths will return to the paths that were set when the program was 

installed.  Selecting Cancel will not restore other values.  Of course you 

can modify the paths again if desired. 

Net Deed Plotter can open and save text (.txt) files, but the files you will 

work with more often are the files that are in the format Net Deed Plotter 

recognizes when drawing maps, images, and notes.  As previously 

mentioned, these files have a default extension of ñ.ndpò.  Do not open a 

file into the Deed Call Editor unless it has a ñ.txtò, ñdesò, or ñ.ndpò 

extension. 
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Net Deed Plotter will cause its Editor to match the type of file you open.  

If you open a text file, the Deed Call Editor will permit word wrapping.  

This minimizes the need to scroll the text.  Word wrapping is not needed 

for most .ndp files. 

Net Deed Plotter permits the saving (exporting) of bitmap files  and DXF 

files of your maps.  Bitmap files can be used to display the map in 

Microsoft Word and certain other word processors.  Bitmaps are often 

used in "Paint" or any other software that can accept a raster image. 

DXF files are polygons of your tract(s) that can be used with GIS and 

AutoCAD.  As requested by our customers, we currently export only the 

polygons.  There are no attributes that will encumber the DXF file. 

The ability to save ESRI® Shape Files has not been provided because the 

DXF files can be read by GIS software.  Shape Files may be added later.  

If this happens, they will be mentioned in a Help topic. 

  


